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Vegetated extensive green roofs can reduce peak runoff amounts during rain events.
As the desire to install green roofs expands beyond roofs with little slope to those with
steeper slopes, often found on residential homes, there is a need to understand how slope
affects runoff. WaterShed, the University of Maryland’s winning entry in the 2011 U.S.
Department of Energy Solar Decathlon competition, is used as an applied research site
where studies like the runoff analysis can be completed, while helping to promote and
demonstrate environmental sustainability and energy consumption efficiency.
Instrumentation installed on the roof will allow high-resolution data analysis, producing
hydrographs. The research has related the sloped green roof to different moisture holding
capacities throughout the different elevations, resulting in a unique energy balance for the
installed green roof. The thin substrate did not significantly contribute to overall runoff
reduction, rather it helped to reduce the overall peak runoff and elongate the runoff lag
after a rain event. This living technology’s performance over time in a new application to
sloped roofs is crucial both to ensure regulatory standards are met and to provide feedback
for future improvements to the design and technology itself.
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1. Introduction

As population size continues to increase, natural resources are growing scarcer as a
result of unsustainable consumption. Continuous development and redevelopment contributes
significantly to environmental impacts both directly and indirectly. Because of land
development the natural flow of rainwater is obstructed as a result of increased installation of
impervious surfaces (e.g., concrete, asphalt, and conventional rooftops) with relatively low
albedo values, elevating surface reflecting value (Hilten, 2005), and high thermal
conductivity, while urban areas suffer from the urban heat island effect (Wolf and Lundholm,
2008). Indirectly, the carbon footprint increases because the construction and operation of
buildings create a high demand for energy relative to pre development periods.

While development is constantly occurring, a strategic integration of natural systems
and the built environment is needed. Standards based on energy and water efficiency within
and around buildings have been developed, through leadership from federally funded
programs like Energy Star (U.S. Environmental Protection Agency, 2014), along with private
programs including LEED (Leadership in Energy and Environmental Design) (Kubba, 2010) .
These standards help to reduce the overall impact on the environment directly and indirectly,
based on many influential factors, including: improved building envelope and mechanical
performance, energy modeling performance (Kubba, 2010), and returning the hydrologic flow
to predevelopment standards (MDE, 2000). While the design of these programs encourage
initial installation of systems like green roofs, the overall performance is not evaluated over
time, giving programs like Living Building Challenge an advantage to site specific

performance and validation (McLennan, 2008).



Green roofs are an example of a technology that can help to mitigate both directly and
indirectly the influences of our built environment. Green roofs provide a thermal mass given
the soil substrate in which the plants are growing, while allowing rainwater to be stored in the
media and consumed over time. Given the soil substrate that can retain stormwater, many
areas, including some in Maryland, are recognizing this technology as a best management
practice (BMP) while providing incentives for its adoption through tax rebates or rain tax
reductions. The rain tax charges residential properties a set dollar value per area of
impervious surface, trying to encourage the installation of Low Impact Development (LID)
technologies. Currently, in Montgomery County, residential properties are eligible for up to
$2,500 in tax rebates, on top of their reduced runoff tax, for installation of approved
stormwater techniques, including green roofs, rain barrels, and porous asphalt, to help manage
stormwater within the Chesapeake Bay watershed (Montgomery County Government, 2014).
Manuals like the Maryland 2000 Stormwater Management Design Manual (MDE, 2000) help
to provide specific design criteria for areas within the state of Maryland. Programs like this
were implemented because of the U.S. Environmental Protection Agency’s (EPA) mandate to
reduce pollutants in the waterways to help improve Chesapeake Bay health (Chesapeake
Program, 2014). Within the state of Maryland, House Bill 987, Stormwater Management —
Watershed Protection and Restoration Program, was passed in 2012 in hopes of persuading
local counties or municipalities to encourage residents to undertake protection and restoration
efforts (Hucker, 2012). As more counties adopt programs for their residents to participate in,
performance analysis of the various systems installed are crucial to ensure federal money is

spent appropriately.



2. Green Roof Literature Review

2.1 Water Benefits

Green roofs are a form of bio-retention, which is implemented to mimic
predevelopment hydrology, while improving the quality of water before it is discharged (He
and Davis, 2011). The implementation of BMPs has a positive impact on the ecosystem; the
goal is to maintain groundwater recharge and base flow, increase surface and groundwater
pollution removal, protect waterways with erosion control, and reduce peak flow during storm
events (Davis et al., 2009). Primary design elements taken into consideration for bio-retention
systems include media depth and composition, underlay configuration, rainfall characteristics
(including depth, duration, and intensity), vegetation, and local climate conditions (Davis et
al., 2009).

Vegetation processes are one of the most influential performance variables, as they
help to manage stormwater once it is absorbed in the substrate and is used through various
plant processes. Different plants use water at different rates, primarily through
evapotranspiration (ET), which is the movement of water vapor from the substrate by way of
transpiration through the stomata of the plant’s leaf (Zotarelli et al., 2013). These plant
processes that contribute to ET depend directly on available energy (water movement and
physical transformation of water to vapor energy requirement), water, surrounding conditions
(i.e., solar radiation, air temperature, humidity, wind speed), and crop characteristics (Allen,
Pereria, & Raes, 1998). These plant functions can be determined by the resources and
environmental conditions presented to the plant (Perini et al., 2011), along with plant
metabolism rates. Traditionally green roofs are planted with sedum due to their physiological

and morphological adaptations present.



2.2 Energy Regulation

Green roofs provide numerous ecosystem services while directly influencing how
energy is consumed and transferred within the roof as a whole (Oberndorfer et al., 2007). The
thermal benefit of a green roof helps to regulate interior temperature, reducing the amount of
energy needed to condition the space, dependent upon original insulation values of roof
structure (D’Orazio, Di Perna, and Di Giuseppe, 2012). Vegetated roofs can be used in warm
climates, by reducing the solar radiation absorption, or in cool climates, by adding a soil
thermal mass layer depending on the overall thickness of substrate (Zinzi and Agnoli, 2012).
Many variables contribute to this benefit, including, but not limited to, pre-existing insulation
values of the structure, thickness of the green roof growing media, regional climate, and ratio
of overall footprint of green roof to building size/height. Previous studies have concluded that
during the summer the energy savings in cooling the interior of a noninsulated building with a
green roof compared to the same building with a standard roof ranged from 15-49%, while for
an insulated building the energy savings ranged from 6-33% (Santamouris et al., 2007).
Ongoing research will provide a better understanding of how energy and thermal transfer are
influenced by green roofs, given the site conditions, green roof types, and geographical

location.

2.3 Thin and Sloped Influences

If the application of green roofs is spreading to residential settings, analyzing the
performance of a sloped green roof is important given the average residential roof pitch is
between 10 and 36 degrees. Commonly, a green roof system is applied to commercial flat
roofs because of ease of installation and maintenance. Both for new and retrofitting

construction, flat or sloped roofs can be converted into green roofs, particularly with thin,



extensive lightweight systems due to the lower structural support load requirements of the
building (Carter and Butler, 2008). The average extensive green roof that is currently
installed has a media depth typically between 4 and 6 inches (Hathaway, Hunt, and Jennings
2008), while intensive green roofs can range above 6 inches to several feet depending on
desired plant selections. For a green roof installation on a steeper pitch, the roof would have
to have additional structural supports, parapets or a grid pattern within the substrate, to
support the downward force of the green roof materials. Because the instillation of lighter
systems is intended for a wider application of buildings, the performance of the sloped roof is
not yet determined; performance is extrapolated from the performance of flat roofs.

With the combination of a lighter, thin system and the varying slopes of residential
homes, additional analysis of the water and energy performance is needed for existing
residential applications. Analysis can provide valuable feedback to the industry, along with
providing homeowners information about how the systems perform depending on the
variables present. Performance data for new technologies and installation types are critical to

state and local initiatives, providing feedback to increase performance analysis.

2.4 Vegetation Review

Most of the green roof systems installed are planted with Sedum, a succulent
stonecrop that can handle times with adequate water stored within the substrate as well as
periods of drought. The various types of Sedum perform differently (Cook-Patton and
Bauerle, 2012). Specific Sedum varieties are usually chosen for local conditions, while plants
self-select over time, and have seasonal year-to-year variations in color and biomass. It’s
important to see how the green roof systems are affected as growing conditions are influenced

by slope and reduced substrate thickness. The different Sedum varieties respond differently to

5



the various micro-zones created within the system. Plant selection is crucial for this
application, as the thin soil will promote periodic drought and rapid fluctuations of moisture
within the soil media (Wolf and Lundholm, 2008). These processes in which plants consume
water depend also on their physiology, which commonly include C3 and C4 plants that
consume water and exchange gas within the stomata during the day when sunlight is available
(Oberndorfer et al., 2007), while Crassulacean acid metabolism (CAM) physiology causes the
plant to conserve water during the day and exchange gases within the stomata at night
(Durhman, Rowe, and Rugh, 2006).

Sedum are CAM plants, plants able to adapt to water availability by fixing and re-
assimilating CO> during nighttime (Cushman and Borland, 2002), while some have the ability
to cycle to C3 during times of high available water. Understanding how the plants within the
green roof system utilize water is crucial to determining the overall water and energy budget
of the roof; thus the CAM physiology of the different species used for green roofs can help
lead to more accurate representation of water and energy flows within green roof systems

(Starry, 2013).

2.5 Research Objectives and Hypothesis

The overall goal of this research is to quantify the water and energy balances of a thin
green roof system applied to a sloped roof in the mid-Atlantic region. | hypothesized that the
performance throughout the elevation of the sloped roof will differ, with the lowest available
water at the top and highest availability close to the bottom. As a result the different water
availabilities will influence the plant processes. | proposed the analysis of standard ET
modeling techniques (e.g., Penman-Monteith ET model) and compared them to measured

conditions for a thin, sloped installed green roof. | hypothesized that the relationship between
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the water and energy balances will help to quantify overall energy transfers within the system,
influencing building performance. The information gathered will help validate the
performance of the system, quantifying retention rates and reduced peak flow during rain
events, while contributing valuable data to evapotranspiration models traditionally used for

green roof applications.

2.5 Plan of Study

In the case of this research project a model residential home named WaterShed has a
sloped roof with a thin substrate green roof. The roof was instrumented with sensors to
monitor the energy and water fluxes during a 3-month period. Two different methods are to
be used for determining ET, ET potential (ETp), and ET actual (ETA). The modeled ET is
considered ETp, as it is predicting ET given, site/surface conditions, and quantity of water the
plants are utilizing. The ETAa is derived from the substrate moisture sensors between rain
events, using the soil depletion method, with the assumption that inputs and outputs are zero
and with the result that any loss in water is caused by ET. The change between substrate
moisture measurements will equal change in substrate moisture and can be directly compared
to the potential ET model. These ET measurements can then be used as variables within the

water and energy budget for the roof to determine balances within the system.



3. Materials and Methods

3.1 Site Description

The green roof studied was on the south module of a sustainable house, WaterShed,
built by a team of students and faculty from the University of Maryland for the U.S.
Department of Energy’s 2011 Solar Decathlon competition (Gensler, 2011). In addition to
hosting a thin, sloped green roof, the championship house was designed to be energy self-
sufficient, producing more energy than it consumed by using 9.2 kW of solar panels, and to
manage its stormwater with an integrated system of green roof, constructed wetlands, large
cisterns, and rain garden. Currently, Pepco, the regional power utility, owns the house and
operates it as an educational sustainability center in Rockville, MD. WaterShed’s green roof is

unique given its slope, thin growing medium, and northern orientation (Figure 3.1).

Figure 3.1 WaterShed’s green roof and PV panel layout.

Orientation and layout of WaterShed’s roof. These butterfly-shaped roofs help to concentrate water
towards the center for rainwater storage.



The green roof is composed of a thin soil tray system, purchased from LiveRoof®,

with an average soil depth of 2-1/2 in, weighing approximately 15-17 lbs/ft? (fully saturated).

The 100% recycled polypropylene trays are 2 ft. long by 1 ft. wide and 1-3/4 in tall with an

interlocking design allowing for easy installation. The substrate consists of 84.5% engineered

shale, 4.5% sand, and 11% compost by dry weight. The original plant selection included

Sedum album ‘Coral Carpet,” Sedum spurium ‘Dragon’s Blood,” Sedum spurium ‘Tricolor,’

Sedum reflexum “Blue Spruce,” Sedum rupestre ‘Angelina,” and Sedum sexangular ‘Utah.’

Appendix A provides supplementary information for each of these sedum varieties. These

sedum are a type of stonecrop within the Crassulaceae family ranging in shape, color, and

growing preferences. The green roof covers 312 ft? (29 m?) of the south (north-facing)

module, while the north module (south-facing) is covered with about 400 ft2 of solar panels

(Figure 3.1). The green roof has a slope of 10 degrees and is waterproofed with white

Thermoplastic Polyolefin (TPO)
membrane, while the solar panel
roof has a slope of 12.8 degrees,
waterproofed with a standing seam
metal roof.

Since the north-facing roof
held the green roof, which is
dependent upon sunlight, a solar
incidence model (Figure 3.2) was
prepared to ensure adequate

sunlight would be available to the

& o HE e =
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Figure 3.2 Solar incidence study of WaterShed.

Solar incidence for entire building given the orientation of
WaterShed. Yellow colors indicate 11+ hours of sunlight, while dark
blue represents reduced exposure.



green roof system. Figure 3.2 also shows this model given the average orientation within the
sky throughout the day with early fall orientation shown. This initial analysis was crucial to
ensure the slope and orientation for the house was suitable to have the green roof on this
slightly sloped northern-facing roof, given the change in orientation of the sun throughout the
seasons. As the sun drops in the horizon during winter months the roof will receive less direct
sun exposure, while summer exposure will be more direct because of the sun’s higher
orientation in the sky.

The green roof sits on top of a TPO white membrane material, which has a border
ranging from 15-20 inches between the vegetation and edge of the roof. This influences the
runoff quantities caused by no retention (white roof) and undetermined retention (green roof).
The underlying interior structure was designed to achieve the greatest energy efficiency

through a complex layering of natural and engineered materials (Figure 3.3). This integration

- TPO Waterproofing Membrane

2x6 Structual Wood

Figure 3.3 Layers within WaterShed’s roof.

WaterShed’s unique structure and insulation have a combined insulation value of R-40+ in the
walls, along with R-50 in the roof and floor.

R-Value units: h-ft2.°F/Btu
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of different materials produces an insulation value of R-04 in the roof cavities. Currently,
traditional American residential construction calls for R-30 in the roof (Northern American
Insitution, 2014), while older homes can be substantially lower in R-value. Within
Montgomery County, currently, the code requires all new residential homes to have an R-19
value in the floors, R-20 in the walls, and R-49 in the ceilings (Montgomery County
Government, 2012).

Sensors were installed throughout WaterShed to help validate the performance of the
various interior and exterior systems. Specifically, within the green roof, moisture and
temperature sensors were installed to provide data for the moisture gradient moving up the
sloped elevations of roof, temperature gradient through the layers of roof materials, and
temperature of the surrounding exposed white roof. Overall data are collected from the
dataloggers every 15 minutes, with varying sub-scan intervals. These sub-scans are averaged
or totaled within the 15-minute window to provide the collected data. Of the 241 new data
points installed on WaterShed, 183 were installed specifically in the green roof and are shown
in Figures 3.4 through 3.7. These various zones were installed strategically to provide slope
moisture and temperature data zones throughout the elevation of slope and the various layers
of the roof. Supplementary information on the sensors used, broken up by the various

systems, can be found in Tables B.1 through B.6 in the Appendix.
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Monitoring System Key

- Central Datalogger (Direct AC wired)

‘ Central Datalogger (with Solar Charger)

. Surface-Mount Thermocouple
. Apogee Infared Radiometer

D Hukseflux 4-Component Net Solar Pyr et

. Hukseflux Soil Moisture Sensor

Q@ Thermocouple Sensor (with Radiation Shield)
[ Hukseflux Soil Heat-Flux

I Pressure Transducer

. Dissolved Oxygen Sensor

. Decagon Leaf Area Wetness Sensor
(O Rain Guage
. RM Young Wind Monitor

. Hukseflux Pyranometer

Figure 3.4 General sensor layout on the exterior of WaterShed. The different zones noted are explained in Figures 3.5-3.7
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~ Substrate Moisture

Ambient Temperature

Vegetation Temperature

Substrate Temperature

Under Tray Temperature

Substrate Heat Flux
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Figure 3.5 Top/bottom zone.

Consists of a soil Water Content
Reflectometer, measuring volumetric water
content (VWC) and temperature of the
substrate. The sensor is installed
approximately 1.5 in below surface of
substrate with probes parallel to the roof and
perpendicular to the slope.

Figure 3.6 Middle zone.

Various levels through the layers of the green
roof:

e Thermocouple with radiation
shield—measuring ambient
temperature (approximately 15 in off
surface)

e Apogee infrared radiometer—
measuring vegetation temperature
(elevated approximately 13 in off
surface)

e Water content reflectometer—
measuring VWC and temperature of
substrate

e Thermocouple—measuring under-
tray temperature (directly under

tray).

Figure 3.7 Middle zone.

Consists of a soil heat flux sensor—
measuring energy transfer though the
substrate. The sensor is installed
approximately 1.5 in below surface (located
in the middle zone)



3.2 Water Balance Measurements

Water balances, or water budgets, are established to determine the various fluxes of water
within a system. These budgets can be applied to any system that handles water, ranging from
an engineered system inside a building to a living system in nature. For this application at
WaterShed a water budget will be applied to the green roof system, helping to quantify the
changes in stored water over time.

The water stored and utilized by the green roof is extremely important, but can be
influenced in many different ways depending on weather, plant conditions, and given site
characteristics. Retention of rainwater helps to reduce the quantity of runoff during peak flow
and runoff quantities of rain events, while also helping to improve water quality. Sensors were
installed within the green roof to help quantify the capacity, during and after a storm, while also

relying on a designed flume box. Figure 3.8 shows the cables under between the tray system.

RN gt g S

Figure 3.8 Green roof sensor integration.

Live roof systems have an interlocking tray mechanism that enables the installed
trays to overlap, preventing movement or uplift from wind. Sensor cables were
positioned underneath the tray to reduce disturbance to green roof performance.

14



Equation Background

For a green roof analysis, the general water budget can be broken down to Equation 1.

P—RO—ET + ASW =0 (Eq. 1)

At the WaterShed site precipitation (P) was measured with the onsite high accuracy
Hydrological Services TB4 rain gauge. This allows the precipitation data to be used as a
reference point for when the system is receiving an input (rain). Otherwise, during times of no
precipitation the variables P and RO can be eliminated. RO is discussed in the next section. This
leaves ET and ASW during times when no precipitation is present, allowing ET to be directly

measured by the change within the substrate moisture over time.

The runoff variable of the green roof is crucial in determining reduced peak flow and
total runoff retention volume, while helping to determine when the green roof substrate is losing
moisture caused by runoff or ET. This runoff data will provide feedback for other variables and
can be used as a benchmark point. The runoff flowing to the gutters can be measured in two
different ways. The first uses designed flume boxes attached to the down spouts of the gutter,
which record the rainwater flow coming off each roof (which is discussed in the following
section). The other method uses the volumetric water content sensors within the substrate of the
green roof, while looking at the soil depletion from the previous time stamp and upscaling the
change of the volume to the entire roof. When the change in soil depletion is positive it is losing
moisture, while negative numbers result in a moisture gain. With this being said, during a rain
event the change would be negative and at the end of recorded precipitation the rate would

switch quickly positive as the soil media is starting to decrease in soil moisture. Because of
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Figure 3.9
limited retention space within the roof, the retention
rate will depend on rain characteristics (e.g.,
intensity, duration), while also being dependent on
antecedent conditions.

Since the green roof is not covering the entire
north-facing roof, the white roof contributes directly Figure 3.10
to runoff, due to no retention (Figure 3.9), followed
by the green roof contributing to runoff (Figure
3.10). Equations B.1-5 in Appendix B interpret the
calculations for the volume upscaled to WaterShed’s
roof footprint. During the time immediately after the

rain stops the total north-facing roof has an

Figure 3.11

elongated runoff timeframe caused by the short-term
retention of the soil substrate of the green roof
(Figure 3.11). During this time the precipitation is
zero, the decreasing rate of soil moisture (ASW) can
resemble measured runoff until a deflection point in

the rate of decrease is reached. After this point the
Figure 3.12

Figure 3.9 Animation of roof performance during
initial rainfall. Runoff only from surrounding white
roof.

Figure 3.10 Runoff from direct runoff and green
roof.

Figure 3.11 Runoff from only green roof after
precipitation stops

Figure 3.12 Animation of ET occurring
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water pores will drain under gravity, contributing to overall runoff (RO), eventually reaching
field capacity. This deflection point indicates when the roof has released all the stored water to
runoff in the gutter vs. the vegetation utilizing the water through the ET process (Figure 3.12).
Until the slope of the change in storage reaches a deflection point, change in storage is still
treated as runoff, but after that point RO can be eliminated. Traditionally, an average threshold
was established that was based on time or on subjectively analyzing slope to quantify runoff
periods. These methods can result in under and over prediction of ET rates and runoff volumes.
When observing the soil depletion over time (Figure D.5 in Appendix), we can notice
diurnal fluctuations along with responses to precipitation events. When it rains the change in
substrate moisture has a negative value. During times when the value is positive the moisture
can either be considered runoff (i.e., draining out of the substrate) or be utilized by the plants
drawing moisture out of the system (Figure 3.13). Occurrences when the change in substrate is
negative during times when no precipitation is present include condensation (dew) forming on

plants during night hours, resulting in added moisture to the system.
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Figure 3.13 Hydrograph in comparison to change in moisture of green roof substrate
September 2, 2014, rain event.

During times of precipitation, change in substrate becomes negative, as moisture is being absorbed
into the growing media, and, immediately after precipitation stops, this change becomes positive
because of drainage and of eventual contribution from ET.

Figure 3.13 shows how the readings will switch to positive immediately after a storm as
short-term storage drains out into the gutter system. During times when precipitation is present
and during the threshold set after the storms, the change in soil moisture is considered runoff and
is not used. During rain events the soil depletion method can be an indicator of how much water
is falling on the roof. This increasingly negative correlation represents a higher rate of rainfall
given the positive change in volumetric water content. The change in VWC within the substrate
was used to populate the soil depletion numbers, converted to millimeter to compare to total

precipitation (mm) during the 15 minute interval.
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Runoff Flumes for WaterShed

In order to get an accurate reading for the runoff from the respective roofs a runoff flume
was developed to record large and small quantities of rainwater flowing off the roof. A 100 year
storm was used as the max flow, given a rainfall of 7.2 inches for the Rockville, MD, area
(MDE, 2000). The purpose of the flume is to determine quantities of water coming off the roof to
determine peak flow reduction, overall runoff lag period after the rain stops, and total rainfall
reduction, while providing an accurate time stamp following the termination of a runoff to
confirm fluctuations in the moisture of the substrate are caused by runoff or direct ET (Using the
volumetric water content [VWC] sensor).

Since the three roofs on WaterShed are different sizes—one has the green roof while the
other two are impervious—we had to consider taking into account peak flow coming off the roof
along with the slow release of water coming from the green roof after a storm. After some
preliminary research of previous methods used for green roof runoff analysis, we concluded that
a method had not been developed for a complete roof analysis both handling high-intensity
storms, while capturing small quantities of runoff. Tipping buckets had a higher accuracy but for
smaller quantities of water, which would be perfect for a lab-based scenario; however, they could
not handle peak flows during average-sized storms. The goal was to develop a mechanism that
measured peak flow and delayed discharge from the roof, by attaching a flume mechanism
directly to a downspout relatively small in size. The development of the flume started with a box
that would attach to the bottom of the downspout, made of the same galvanized aluminum
material, and which housed a weir inside (VV-notch that can relate height of water within the V to
a given flow rate). A pressure sensor would record the water level as the runoff flowed through

the V-notch. Traditionally, weirs have been used in much larger-scale applications (stream flow
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analysis) compared to what was needed specifically for WaterShed. To start | looked into the
design of the flumes and how they could be integrated unnoticeably into WaterShed’s design for
peak flow rate data off the respective roofs. The V-notch weir equation was used (Eq. 2), which

is traditionally used as a flow rate analyzer for an open channel stream (Moore, 1975).

Q= 4.28*C*tan(§)* (h + k)>/? (Eq. 2)
Where:
Q Discharge  (cfs)
C Discharge Coefficient (d.u.)
0 Notch Angle  (deg)
h Head (ft)
k Head Correction Factor  (ft)

(U.S. Department of the Interior, 1997)

Table 3.1 Storm Sizing Calculation for Flume.

Predicting flow rates through various angled V-notches given the respective roof sizes.

The V-notch angle (0) is determined by the peak flow and desired height. A taller height

Rain Depths for 24-Hour Storm Events
1yr24hr 10 yr 24 hr 100 yr 24 hr
2.6in 5.1in 7.2in
Green Roof 0.0304 CFS 0.0596 CFS 0.0841 CFS
PV Roof 00386 | crs | 00756 | crs | 01068 | cFs
Bathroom 00048 | crs | 000943 | crs | 00133 | crs

Green Roof: 504.59 ft? (72,659.52 in?)

Bathroom Roof: 79.89 ft* (11,505.46 in?)

PV Roof: 640.65 ft? (92,253.60 in?)

will allow the angle to be smaller resulting in a greater elevation change, which will produce
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more accurate flow data. To start, calculations were completed to determine the peak flow
coming off the roofs and the required angle of the V-notch, due to the different sizes and
retention rates of the respective roofs. Table 3.1 shows the steps taken to determine what size
storm the box angles could handle. We obtained information about rain depths associated with
storm event years from the Maryland Stormwater Design Manual, specifically for Montgomery
County (where the WaterShed site is located). The storm events were applied to the respective

roof sizes and roof surface type which resulted in a predicted flow.

The calculated flow rate was then applied to equation 3, several standard angles, and the
equation was solved for h. The angles were the dependent variable for this equation, as they
determine the height of water level in the flume box, helping to ensure the size of the designed
box would be tall enough to handle the storm’s flow with the given V-notch angle. The angles
for each box were adjusted until the height was within the previously determined dimension of
the box. The final angles determined for the three flume boxes were: Green roof 50°, PV roof
70°, and bathroom roof 40°. Appendix F shows the detailed drawings for each of the flume
boxes. The water would fill up to the bottom of the VV-notch, which would act as the base height
until a storm event occurred and then increase in height as runoff started. This base height would
stay relatively close to the bottom of the VV-notch between rain events due to no

evapotranspiration (covered box), leaks within box eliminated, and no other inputs.
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As the intensity of a storm
increases, the overall height of water
will increase within the box at a non-

linear rate due to the V shape of the

water outlet, letting a higher quantity of

water exit during higher rainfall events, Baseline
‘Height
while being able to measure smaller

events or lags in runoff more accurately. e

All the variables within the V-notch Figure 3.14 Labeled flume diagram.

One of these inserts per flume box, with the angle the
weir equation are constants except for only variable changing.
the height of water, which is measured above the bottom of the V (baseline). The variables K
and C are dependent upon the angle of the V-notch (calculation shown in Appendix C). In order
to measure this the pressure transducer data must be subtracted by the baseline measurement
(constant), which will give you the height above the V-notch, resulting in a flow rate. Figure

3.14 shows the various heights described here, while the head above the V-notch is the desired

measured point needed and only available during storm events.
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Design

For the WaterShed site we needed a
box that would be able to attach to the
gutters of the house itself, so the design of
the box would allow the gutter to come into
the box without losing any water. In
Figure 3.15 the different sections of the
box are displayed. The water entering the
flume box would come from the gutter to
the far left and contribute to the volume of
water inside the box. The water would
then flow under a baffle, which helps

reduce the disturbance of the water as

;';x

Figure 3.15 Flume rendering.

Cross-sectional view of flume showing back baffle
and V-opening.

it flows through the V-notch, while allowing water to flow underneath. Once on the other side

the rainwater has the opportunity to flow through the V-notch, depending on the rate of water

entering the box. And the water level is determined by the pressure transducer at the bottom of

the box, providing data for the overall flow equation.
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Flume Calibration

Due to irregularities between the sensors’ water levels readings, a flow calibration was
undertaken to ensure the height given by the pressure transducer corresponded to the correct flow

rate coming through the VV-notch. To Table 3.2 Flume Calibration Flow Rates.

accomplish this the water hose available Green roof flume box initial readings for
flow rate after initial heights were recorded.

onsite was set to various flow rates and

. Sensor Height | Correspondin Hose Flow
put through the flume box itself. Table (mm) g Flowr()CFS) 9 (CFS)
3.2 shows the different flow rates 168 7 10.00238 0.009957
172.2 -0.00304 0.0096
achieved by the hose and the correction 145.8 -0.00037 0.00184
150.6 -0.00063 0.00272
factor taken into account for each of the 156.6 -0.00109 0.00398
. 159.3 -0.00131 0.00457
respective flume boxes.
163.4 -0.00179 0.00582
We achieved the flow rate from 166.2 -0.00213 0.0065
the hose by slowly turning on the hose y =-3.146 x + 0.0006
valve and measuring the flow rate at 8 0.012
different flows. Two timers measured oor
[Ta)
. 0008 O
the time it took to reach a volume of 1 .
- - - - - - OIOOG g
liter within a measuring device (Figure 2
0.004 ;
3.17). This took place a total of 3 y < -3.1459% +0.0006 2
R2=0.9238 0.002
consecutive times for the respective
0
-0.004 -0.003 -0.002 -0.001 0

flow rates, and we averaged the 3
Flume Flow Rate (CFS)

measurements. Table 3.2 and Figure _ ) _ o
Figure 3.16 Linear regression calibration for flume

3.16 show these combined averages for  Correction factors returned from this linear

regression, which were used for equation 3.
each of the different hose flows.
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Figur 3.17 Testing se flow eore flme calibratio.
Once these correction numbers were determined for each flume, the correction multiplier
and y-intercept were added to the respective flow rate equation for each of the flume boxes. This
helped to improve the accuracy of the flow due to a variation within the water level sensor from
the various flumes. Once these correction numbers were added another flow test was completed
to validate that the values added were accurate, having a correlation of 90% or higher (results are

found in Appendix H).

Water Balance Conclusion

Equation 1 is manipulated to solve for ET, as the other variables are easier to quantify
during periods of precipitation. ET, of interest during times when it is not raining, can now be
computed by using the change in storage over time (Marasco et al., 2014). The data become
more accurate as the average time intervals become longer (greater than 7 days) because of small

changes within the substrate that are hard to traditionally quantify (Allen et al., 1998).
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ETa was estimated from the soil depletion methods, which requires that P and RO are
zero in Equation 1. RO was known to be zero when the flume was reading zero. This usually

occurs within a few hours following the termination of a rain event.

3.3 Energy Balance Measurements

The energy balance of an ecosystem, such as a green roof, includes the shortwave and
longwave radiation, sensible heat exchanged with the atmosphere, latent energy of
evapotranspiration and conduction of heat through the substrate (Eq. 3). The attributes of an
ecosystem (e.g., percentage of area covered by vegetation, leaf area index, leaf color) influence
each of the energy flows in the energy balance. The latent energy associated with transpiration is
typically a large part of the energy balance and major pathway for removing heat created by solar
and longwave absorption.

R,—G— AET—H =0 (Eq. 3)
Where:
R,  Netradiation
G Soil heat flux

AET  Latent heat flux
H Sensible heat

(Takebayashi and Moriyama, 2007)
At the WaterShed site the net radiation (Rn) was the sum of net shortwave and net
longwave radiation, while soil heat flux (G) was measured directly within the green roof

substrate, while ET was calculated through the water balance equation discussed in Section 3.2
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or through a standard model. This leaves sensible heat (H), for which equation 2 can be solved
to estimate (see Eq. 3b). Figure 3.18 helps to visually show these variables, while Figure 3.19

breaks down the H=R,—G— AET (Eq. 3b)  net radiation variables.

The energy balance in Equation 3 R
assumes that the change in heat stored
is negligible, which is justified over a
24-hour period because the change in

heat stored is small in comparison to
BRI AT AL T I R T Qe By

any of the individual flows during

that period. Since H was not

measured with any instrumentation, ~ Figure 3.18 Visual flows of energy balance equation

variables.
Equation 3 was solved for H to
) . R Net
derive Equation 3b. Shorkieve
Radiation
(Visable)
Equation 3b will help s Net
RuN Long-Wave
Riout Radiation

understand how energy is used (nfared
i R. out

within a green roof itself, while

seeing what benefit it contributes to

the overall performance of the

house (Allen, Pereria, and Raes,
1998) The energy ba'ance Flgure 319 Net I‘adlatlon I||UStI‘atI0n

Downwelling radiation is entering the green roof,

equation looks at inputs coming into while upwelling radiation is leaving the green roof.
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the system, solar and longwave radiation, while the other variables utilize the energy. (Specific
instrumentation can be found in Appendix B). The net radiation sensor used took into account
the sum between net shortwave and net longwave on the roof. For this research project net
radiation and soil heat flux are measured at a 15-minute interval directly through Campbell
Scientific instrumentation (Appendix B). We can calculate ET multiple ways depending on what
variables are measured. The water balance is approach discussed in Section 3.2, of the traditional
method for modeling ET rates with FAO (Food and Agriculture Organization of the United
Nations) methods (Allen, Pereria, and Raes, 1998).

The FAO equation is based on the Penman-Monteith model and takes into consideration
standard localized meteorological data, which are often obtainable but depend on site. In 1948
Penman computed this equation with the combination of the energy balance and mass transfer
methods for the original open pan evaporation method, using local climatological data of
sunlight, temperature, humidity, and wind speed. Over time this method was progressively
developed, adding other variables including reference crop resistance factors (Allen, Pereria, and
Raes, 1998). Empirical formulas have been developed around a crop reference, used to best
represent ET of the desired crop. Many of these formulas have been tested in various conditions
and locations in which the FAO Penman-Monteith was recommended as the standard method for
defining reference ET in 1990 (Allen, Pereria, and Raes, 1998). This crop reference takes into
account the resistance, crop height, crop roughness, reflection, ground cover, and rooting
characteristics for different types of plants under the same normal environmental condition

(Allen, Pereria, and Raes, 1998).
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Penman-Monteith Equation:

Where:

Cn
ET _ 0.408A(Rn—G)+ym(es—ea)u2
P A+y(1+Cquy)

Slope of saturation vapor pressure curve

Dependent on temperature sensor °C
Net radiation

Net radiometer W/m?
Heat flux density to the soil

Soil heat flux sensor W/m?
Psychrometric constant

Dependent on atmospheric pressure kPa
Numerator constant (depends on crop reference)

Constant
Mean daily temperature

Temperature sensor °C

Mean saturation vapor pressure
Dependent on temperature sensor
Mean actual vapor pressure

Dependent on humidity %
Mean daily wind speed

Wind speed/direction sensor m/s
Denominator constant (depends on crop reference)

Constant

of the Penman-Monteith equation.

(Eq. 4)

kPa/°C
W/m?
MJ/m? day
kPa/°C
D.u.

°C

kPa

kPa

m/2

(Allen, Pereria, and Raes, 1998)

Appendix F contains supplemental information to support subcomponents and variables

The Penman-Monteith equation (Eq 4) is traditionally analyzed for a 24-hour period by

averaging the daily values of the various variables (Lovelli et al., 2008). We generally observe

ET over longer periods of time to see overall trends vs. detailed performance for individual days.

The variables used for the equation can sometimes be difficult to populate for various sites

because of data resolution and availability. When planning the monitoring system installed in

WaterShed at the final site parameters, contributors within the various equations, such as the
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Penman-Monteith, were taken into consideration along with location and what interval was

appropriate.

3.4 Green Roof Vegetation Assessment

To assess the green roof, measurements for both leaf area index (LAI) and percentage of
vegetation cover were done during the data collection period. These assessments measure the
biomass changes of the plants over time and can relate other site specific measured variables to
these changes over time. The LAI is commonly used to measure the canopy density rather than
simply area covered. A 1 m x 1 m square with 1-inch intervals was made, where we randomly
selected 5 points within each quadrat to measure LAI. A point was selected by randomly
selecting an X coordinate and a Y coordinate (Figure 3.20). At this coordinate a count was done

for the number of leaves 5
s

%

touching the object inserted
through the media. Within
each of the 9 zones on the roof
(Figure 3.4), 5 points were
chosen (from the randomly
generated coordinates) per data

period. This number was then

divided by the measured area Figure 3.20 Grid pattern used for measuring LAI, 1m x 1m
in size.
of the quadrat (1 m?) to yield

the zone LAI (number of leaves per area).
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To assess percentage of cover of the roof, we took photographs of each quadrat within
zone. We analyzed the pictures using a software called ImageJ, which enables the user to trim
and crop an image and select a certain color spectrum to focus on an area of vegetation only.
These color spectrums were determined by changing the hue, saturation, and brightness of pixels
to select, agreeing upon thresholds that select the greatest area of vegetation. The software
computes the pixel quantities for the total area and the area of vegetation, providing a pixel ratio,
which represents percent cover (Carter and Butler 2008). This is a method used for other percent
cover applications along with other analyses; methods can be found in Appendix E. Depending
on the season the color spectrum of the canopy will change, which will determine which colors

to analyze in the software.

3.5 Data Collection

The data collection period for this thesis was June 18 through September 15, 2014, which
in part was dictated by when the data collection systems were installed. However, the data
collection is ongoing so long term research can be conducted. For this thesis the data collection

was stopped at midnight on September 15",
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4. Results and Discussion

4.1 Water Balance

Each of the 30 day periods during the data collection period received above average
rainfall (Table 4.1). Daily precipitation events were mostly evenly distributed throughout each
month with the exception of a relatively dry 2 weeks in late July (see Figures D.1-D.5 in
Appendix). Since the substrate is 63.5 mm thick with an average porosity of 25%, the result is a
15.8-mm potential. Both organic matter and root density decreases the overall water storage,
which contributes to the 25% porosity. Given the variability in rain events, the time between rain
events is the biggest influence on how much of that 15.88 mm of rain is retained within the
substrate. A significant amount of rain fell at the location during the summer compared to

monthly averages in past years.

Table 4.1 Total Precipitation and Mean Daily Site Conditions.

June 16-July 15 July 16-August 15 August 16-September 15 Average

Total
Precipitation (r?]trf:) 154.94 (6.10 in) 130.8 (5.15in) 112.27 (4.42 in) 398.02 (15.67)
Historical Precipitation (mm) 88.65 (3.49 in) 73.66 (2.9 in) 97.28 (3.83in) 250,50 (10.22)
Mean Daily
Total Precipitation Volume (m?) 0.44 0.33 0.24 0.34
Runoff Volume (m?3) 0.40 0.31 0.21 0.31
% Retention 9.69% 7.01% 11.41% 9.37%
ET (mm/day) 0.27 0.19 0.24 0.23
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This correlation shows that with a moisture increase the rate of ET also increases. This
reduced rate of ET with lower water availability is crucial to note within the performance of the
system. This can mostly be attributed to the Sedum plants and their ability to conserve water
during periods of low available water and shift to higher consumption rates during times of high
available moisture. When using models to predict ET, the performance of the plants and exposed
soil is drastically influenced by not included variables of available moisture and vegetation
conditions within the system. The plants have varying rates of transpiration, while the
evaporation of moisture changes with exposure.

ET is highly dependent upon available moisture within the substrate for the plants in the

system to utilize. The linear regression in Figure 4.1 shows the strong positive relationship (R-
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Figure 4.1 Effect of VWC on ET during data collection period.

Mean hourly correlation between available water and ET rate during entire data collection
period. (Rain threshold applied.)
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squared value of 0.77) between the moisture and ET rate. Previous studies have validated the
correlation between lower ET rates and lower availability of soil moisture (Marasco et al., 2014).
With Watershed’s thin green roof system, it was able to hold less moisture than a 100 mm thick
extensive green roof, having an hourly ET rate of 6.4 mm/day during July, while WaterShed’s
green roof was around 4.49 mm/day. The higher average rate of ET is a result of more available
moisture within the substrate.

Figure 4.2 shows an 11.5mm precipitation event on September 6, 2014, while the starting
VWC average was 0.037 m*m?3, and 91 hours since the last rain event. During this event the

green roof provided a 15 minute delay in runoff, a 44% reduction in peak flow, and a 1.5 hour

runoff lag.
0.018 = 16
- 14
0.015
= 12
—~ 0.012 R
7 L 10 £
L )
2 S
2 0009 L8 2
- >
% 6 &
B ©
= 0.006 =
’i’ - 4
0.003 /
- 2
) . — L,
15:15 15:37 15:59 16:20 16:42 17:03 17:25
Time
Precipitation (CFS) Green Roof Runoff (CFS) Precipitation Totalized (ft"3) Runoff Totalized (ft*3)

Figure 4.2 Hydrograph for the green roof runoff.

September 1, 2014, rain event -- 11.5 mm total Instantaneous runoff flow rates and totalized
runoff volumes for one rain event, showing reduced peak flow and elongated runoff period
after rain event.
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Figure 4.3 shows the hydrograph from WaterShed 's green roof during an 11.5-mm rain
event collected by the flume weir. The rainfall lasted for an hour. This retention rate is highly
dependent upon the soil thickness, and slope, with WaterShed’s thin tray system having minimal
storage capacity. The retention rate is also influenced by antecedent conditions, where the roof’s
substrate could be more susceptible to accept moisture during precipitation if dry compared to
times when the substrate is close to saturation. Figure 4.3 shows a rain event that occurred on
September 1, being 21.5 hours since the last rain event and with the average VWC reading
before precipitation started 0.078 m3/m3. The rain lasted around 45 minutes. If the green roof
started out with a higher volumetric water content there would be an overall lower total retention,

due to lower moisture retention cavities. While if the volumetric water content were to start
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Figure 4.3 Hydrograph for the green roof.

September 6, 2014, rain event -- 16.25 total. Runoff flow rates and totalized runoff volumes for one
rain event.
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lower around 0, there would be a greater demand within the moisture retention cavities to be
filled, resulting in an overall larger retention.

During the rain event, the green roof provides a 15-minute delay in runoff, a 67%
reduced peak flow, and a 5-hour runoff lag, while only sustaining a 4.5% runoff retention. This
rain event’s intensity may have caused more water to become instantaneous runoff due to a
pooling effect on the roof. The starting volumetric water content was around 0.078 m3/m?,
Although the total retention was only 4.5%, the reduced peak flow is a great indicator that the
rainwater was absorbed, coinciding with the long runoff lag.

Since the total retention is much lower than on thicker roofs, the anticipated goal of this
thin system includes short-term retention in order to dry out before the next storm event. With
this being said, the green roof is managing the peak flow vs. reduction in overall rainwater
volume. This can provide feedback that every green roof and installation are different, given

their different hydrologic performance.

4.2 Flume Results

Using a new method for measuring runoff we wanted to see the correlation between the
data collected from the flume and the soil depletion method collected with the VWC sensors.
We compared these methods for several storm events (Figure 4.4). Based on the R-squared value
of 0.51 there is a correlation between the two runoff-measuring techniques. In comparison to a
perfect correlation (1:1 line shown) on average the flume underpredicted during times of low
precipitation, while overpredicting during times of high rainfall in comparison to the soil
depletion method. Because of flume calibration issues the rainfall events measured by the flume
are limited to these 11 storm events for this thesis. The 11 storms are shown in Table 4.2. With

this lower accuracy during times of lower precipitation, the pressure transducer sensor may not
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be as accurate with it not picking up smaller changes in water level during the lag period. Future

analysis of the flume data along with further soil depletion data collection is recommended for a

more transparent understanding of the flume performance during the rain events. Alternatively,

it could be that the soil depletion method over predicted runoff for small events, under certain

conditions, following the cessation of precipitation, soil depletion can be due to runoff and ET.

If ET was large, then the RO estimate by soil depletion would overestimate RO.
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Figure 4.4 Linear correlation between flume runoff data and change in soil moisture.

A total of 11 storms recorded between 8/21/2014 — 9/13/2014.
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When using soil depletion methods for ETa a threshold had to be established based

around precipitation events and the measured runoff from the flume, providing a timestamp

feedback to other analysis. This threshold took into consideration 11 rain events, averaging the

total time from when precipitation stopped to when runoff stopped (Table 4.2). This threshold

was averaged to get a stronger average threshold to use for previous rain events when using the

soil depletion method. The average threshold consists of an 88.6-minute (rounded to 1.5-hour)

window after the last recorded precipitation, allowing this averaged time stamp to be an indicator

for the separation of runoff and ETa representation. Previously, during this average 1.5-hour time

period after the rain, the soil depletion within the substrate was not known to be contributing to

the total runoff or ETa.

Table 4.2 Runoff Lag Flume

Measurements.
Timestamp Runoff Lag (min)
8/21/2014 18:30 15
8/22/2014 16:45 60
8/23/2014 9:00 90
8/23/2014 13:45 120
8/31/2014 18:15 15
9/1/2014 15:45 75
9/1/2014 23:30 105
9/2/2014 16:30 180
9/2/2014 23:15 105
9/6/2014 18:45 165
9/13/2014 11:00 45
Overall Average 88.6
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Figure 4.5 Rain event hydrograph.

Red box represents lag period between time rain
stops and runoff is last recorded due to green roof
short-term retention. Blue circle represents
reduced peak runoff flow.
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Figure 4.6 Mean cumulative daily ET for each month.

ETa is shown on a 24-hour average monthly basis in 15-minute intervals in Figure 4.6.
Previous studies have found the summer average ETAa rate to be 3.68 mm/day (Marasco et al.,
2014) with Watershed’s being 0.23 mm/day (both using a K¢ reference value of 1). The
Marasco study took place in Manhattan, NYC, where an unirrigated 10-cm (3.94-in) extensive
flat green roof planted with sedum and native plants was monitored to estimate ET rates. In
comparison to the Marasco study (Table 4.3) WaterShed’s average ETa rates was significantly
lower and varied month to month. In comparison to Watershed’s monthly cumulative ET, the ET
rates differ given the experimental conditions. Because of WaterShed’s thin soil green roof and
its inability to retain significant long-term rainfall, these fluctuations in available moisture did
happen more regularly compared to the fluctuations in the 4-inch growing media used in

Marasco’s study, along with the sloped roof. It can be noted that the WaterShed site received a
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higher average precipitation during this data collection period (Table 4.3), while the mean

precipitation value was not provided for the Marasco study.

Table 4.3 ET Rate Comparison.

Monthly Averages of ET (mm/day) *(Marasco et al., 2014)
June July August September
Previous Study* 4.2 3.45 4.8 2.3
WaterShed 0.11 0.29 0.19 0.31

4.3 Sloped Roof Contribution

With the given slope of WaterShed’s installed green roof, the retention rate moving up
the elevation of the slope was predicted to be different because of gravity acting on the moisture
as it is being pulled further down the substrate towards the bottom of the roof. This moving
moisture would provide additional moisture to these middle and bottom zones. The top would
have a lower retention volume compared to both the middle and bottom sections, while the
bottom would always have the highest retention volume as a result of available water flowing
down the roof. Figure 4.7 shows a summarized detailed view of the soil moisture, during August
31% — September 16™, 2014, while Figure D.4 in Appendix D shows the fluctuations throughout

the entire data collection period.
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Figure 4.7 Stored moisture throughout slope of roof.

The different stored moisture averages moving up the elevation of the roof, while diurnal
cycles (major vertical grid lines represent midnight) are mimicked by all the levels, having a
higher decrease rate in stored water mid to late day.

During the time period shown in Figure 4.7 the trend is as follows: after rain events,
which can be noted at the large positive peak in all 3 VWC zones, the lower elevation has the
highest moisture content, followed by the middle and top elevations, respectively. After about a
day after the rain event soil moisture is depleted mainly due to ET. Each zone exhibits a similar
pattern of decline in VWC because ET is responding to similar ambient conditions. As the
plants continue to utilize the available water within the substrate, they will reach a stress point
that causes their normal consumption to change, influencing the plants physical processes. At
this point the moisture within the substrate is harder for the plants to utilize, resulting in a slower

decrease throughout the day or a lower peak of ET during the day. Since the top zone has the
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lowest quantity of water it experiences the side effects of lower available water before the other
two zones. At a certain period after the rain event all three zones get close to the same available
moisture, given sedum’s adaptation to conserving water when available water is low. It can also
be noted that directly after a storm event the available moisture within the top is substantially
lower than within the middle and bottom, which share comparable levels immediately after storm
events.

The variability among the top, middle, and bottom zones represents the overall influence
the slope has on the moisture retention within the substrate. Figure 4.8 shows the overall 9 zones’
standard deviation compared to the available moisture, while Figure 4.9 shows the 9 zones broken

up into top, middle, and bottom.
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Figure 4.8 Mean daily soil moisture of all 9 zones within green roof compared to the standard
deviation among the zones, influenced by the roofs slope.
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Figure 4.9 Mean daily soil moisture compared to standard deviation of the respective 3
elevations up the slope of the green roof.

Unlike Figure 4.8, Figure 4.9 breaks up each zone to see the influence slope may have.
Figure 4.9 illustrates the influences of slope, given the bottom has a greater potential to receive
water from the other two zones, corresponding to the varying VWC data in Figure 4.7. The
slopes of the trend line relate the available moisture within the substrate to the variation from the
average. The bottom trend line has the steepest slope, followed closely by the middle, with the
top having a very low slope. The steeper slopes have more fluctuation due to more available

moisture flowing down the roof slope, while the lower sloped trend line shows less variation.
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4.4 Net Radiation

The installed radiometer automatically calculated the longwave and shortwave coming
into and reflecting off the green roof system. The net radiation was the sum of the incoming
shortwave and longwave minus the sum of the reflected shortwave and emitted longwave.
Figure 4.10 gives an example of the typical amount of shortwave, net shortwave and difference
during a 7 day period. The energy that is considered net radiation is energy input to the green
roof, contributing to ET, latent heat flux, sensible heat flux, and soil heat flux (Equation 4).

Table 4.4 and Figure 4.11 summarize the energy balance for the green roof. In this case the soil
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Figure 4.10 Solar radiation experienced by green roof on WaterShed.

Net difference represents the energy input of the green roof system.
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heat flux is positive when heat is leaving the system to enter the atmosphere and negative when

heat is transferred through the system to the roof.

Table 4.4 Mean Daily Energy Balance Equation Variables.

Mean Daily ~ June/luly July/August  August/September | Average | % Radiation
Net Radiation [W/ m?] 119.90 109.03 99.16 108.25
Latent Heat Flux [W/m?] 6.53 6.18 5.99 6.29 5.7%
Soil Heat Flux [W/m?] -2.81 -1.55 -0.39 -1.28 1.1%
Sensible Heat [W/ m?] 115.56 104.02 93.54 103.22 93.2%
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Figure 4.11 Mean 24-hour energy budget for the summer
(June 18 — September 15, 2014)

Due to low measured levels of ET, the Latent energy is not noticeable in this graph.

Appendix J provides individual energy balance variables graphed with appropriate scale.
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This energy budget graph helps to show the average flux of energy within the green roof
system on a 24-hour basis. Because sensible heat is an important variable to model, it is highly
influential on the net radiation energizing the system, followed by the consumption of energy
through heat transfer through the media to the roof (soil heat flux) and consumption by the plants
used through ET processes (latent heat flux). Other studies have found the maximum sensible
heat flux to be around 360 W/m?, while it can get as low as 2 W/m? depending on angle of roof
and variety of plants within the system (Takebayashi and Moriyama, 2007). This sensible heat
value is important to calculate, as it helps to feed back to the reduction in ambient temperature of

the surrounding area caused by the application of the green roof.

4.5 Plant Performance

On average we performed bi-weekly sampling to determine the percent cover and leaf
area index (LAI) of the green roof. The data were collected within the nine zones of the green
roof, corresponding to the sensor locations. Table 4.5 and Figure 4.12 show LAI during the

collection periods.

Table 4.5 LAI Measurements from Green Roof.

Zonel Zone2 Zone3d Zoned4 Zone5 Zone6 Zone7 Zone8 Zone?9
6/26/2014 1.6 2.2 1.6 1.6 2.2 1.2 1.8 0.8 0.8
7/10/2014 2.6 2.4 2.4 2.4 2.6 1 1.4 1.8 1.6
7/25/2014 0.4 0.4 1.4 2.4 1.6 2 1.4 0.6 0.4
8/22/2014 1.4 0.8 0.6 1.4 0.6 0.2 1.8 0.6 1.6
9/5/2014 1.8 0.4 1.2 0.8 1.2 3 1.6 0.8 1.6
9/18/2014 1.8 1 1 0.6 1 1.6 0.6 1.2 1.6
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Figure 4.12 LAl trend from different elevations in slope and overall average.

With this data set over the course of 3 months, the LAI had no significant trends within
the elevation of the slope of the green roof. The overall trend peaked during mid-August, while

the lowest recorded measurement occurred in early September.

For the percent cover each data collection period Table 4.6 and Figure 4.13 display the
percent cover data from the 9 zones. Overall the different zones follow the same trend over time.
Percent cover depends on the geographical region where the roof is located. This could result in

a margin of variability between data sets, given the poor health of the plants initially.
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Figure 4.13 Green roof individual zone percent cover.

The percent cover trend throughout the data collection period is mostly similar for all 9 zones,
with one exception occurring during the 8/22 collection day (outliers within zones 4 and 6).

Table 4.6 Percent Cover Measurements from Green Roof.

Zonel Zone2 Zone3 Zone4 Zone5 Zone6 Zone7 Zone8 Zone9

6/18/2014
61.7% 63.1% 69.7% 70.1% 70.7% 74.8% 66.9% 62.6% 72.0%

6/27/2014
46.7% 44 8% 42.9% 48.0% 54.0% 52.9% 37.9% 50.4% 46.2%

7/10/2014
40.9% 35.8% 40.6% 41.7% 50.9% 45.6% 48.2% 41.5% 43.0%

7/25/2014
51.8% 49.4% 57.9% 59.0% 53.6% 56.2% 58.5% 62.9% 63.1%

8/22/2014
41.0% 38.1% 43.1% 21.9% 55.8% 67.3% 40.6% 49.7% 45.8%

9/5/2014
45.2% 35.3% 51.0% 40.4% 54.6% 42.5% 56.6% 50.5% 54.2%

9/18/2014
49.4% 29.8% 44 4% 47.0% 54.3% 36.1% 58.5% 57.2% 62.7%
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To compare these vegetated measurements with the conditions the plants were
experiencing requires a comparison to available moisture within the substrate. Figure 4.14 shows
the individual zone’s VWC during the data collection period. The trend during the data
collection period is not due to soil moisture levels, as June showed relatively low soil
moisture, while percent cover was the highest overall recorded. The first peak in VWC occurred

in late July (7/27), when the plants’ second peak took a few weeks longer to react (8/22).
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Figure 4.14 Green roof VWC for each zones going up the slope of the roof.

Overall, a trend with available moisture and plant cover can be noticed with plant
response time taken into consideration. Figure 4.15 provides the direct correlation between the
percent cover and average VWC between data collection periods. Overall, with the relatively
poor canopy coverage the performance of the system is not tightly correlated to percent soil
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moisture. However, this wide correlation is important to note given the higher frequencies of
wet and dry periods due to the thin growing media and consumption through ET over time. This
will take longer to analyze giving the plants time to recover to full functionality. When looked at
independently some of the zones exhibited a stronger correlation than others, although additional
data would improve the quality of this analysis (Appendix I). Because of plant response time
and a low collection interval for plant performance the trend will be hard to perceive with this
short data collection interval. The slope and thin-soil growing media are major contributors to
this difficulty, given the high fluctuation rates of available moisture. This analysis will have to

be examined for longer periods of time.
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Figure 4.15 Overall soil moisture and percent cover correlation.
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4.6 ET Measured vs. Predicted

The traditional method for ETr of a green roof (Penman-Monteith equation) was
analyzed at different intervals using the 15-minute data collected onsite, providing a direct
comparison to the ETa, measured by change in stored water, over time (Figure 4.16). Over the
course of the data collection period these two indicators of ETp fluctuated with over- and
underestimating in comparison to ETa. The ETp model was consistently between 60 and 130
W/m? during times between rain events (ET occurring during this time is minimal, while having
no direct method for measurement in this thesis), with minimal fluctuation. In comparison ETa
drastically increases during times following precipitation and decreases at a diminishing rate
between rain events due to reduced moisture availability. If we observe the mean ETp model
over longer periods of time (as is traditional), the two methods have a stronger correlation. But
during times with higher resolution, intervals have too much variability, making the two methods
incomparable.

Since the VWC sensors within the substrate are providing data for the soil depletion, this
presumably more accurately represents water usage within the green roof system at a higher
resolution. The different mean time intervals for the two variables returned drastically different
ET values given the amount of fluctuation that occurs with 15-minute data. Although all of the
data frequencies (hourly, daily, and weekly) resulted in ETp overpredicting ETa, the correlations
were drastically different (Figure 4.17 — 4.19). This is an important aspect to note, given the
resolution the data is analyzed results in a different ET prediction when assuming the soil

depletion method is ETa.
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Figure 4.16 Mean daily ETp, ETa, and precipitation.
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Figure 4.19 Weekly ETp vs. ETacomparison.

Although soil moisture is not a parameter in the Penman-Monteith model, soil moisture is
an important aspect that drastically influences ET rates. However, as shown in Figure 4.16, ETa
is directly related to the availability of soil moisture for this thin, sloped green roof. Thus, it is
imperative that caution be used when applying the Penman-Monteith model to green roofs
because they can often be water-stressed.

Since the green roof was not irrigated the variability of available water changed
dramatically during the data collection period. This was mostly done to mimic the natural cycle
a mature green roof would experience in the mid-Atlantic region and resulted in a few extreme
dry periods during mid to late July. The Penman-Monteith model is not responsive to available
substrate moisture, only surrounding conditions. Studies have shown that as a result of average
monthly variations in weather conditions, the Penman-Monteith energy model shows a

comparative underestimation of ET. Other parameters would have to be taken into
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consideration, as the equation shows no variation in soil moisture (Marasco et al., 2014).
Although these models do average out over longer periods of time, the fluctuations are important
in performance using higher resolution data. We can conclude with the data collected that the
Penman-Monteith does not accurately predict ET in its original form. We believe this analysis
helps show how a system operates under normal weather conditions considering the different
stress types which are experienced within the averaged longer periods of observation for
modeling ET. The ETa measured through the soil depletion method helps to show these drastic
performance changes over the periods of available to low available moisture within the substrate.
Additional variables can be added to the Penman-Monteith equation to better predict ET,
giving a Kc and Ks values. Kc or Crop Coefficient is a multiplier that helps to account for
specific plant species differences within ET modeling, given different plant performances. To
take into consideration the available water, Ks is an adjustment for systems that are less than
well-watered conditions (Starry, 2013). Since the original Penman-Monteith equation was
intended for a well-watered system with tall fescue like grass, these variables would help to
mimic more of a green roof system, reducing the overall predicted ET values. This would be a
possible next step in comparing the Penman-Monteith model to actual measurements of the

green roof.

4.7 Overall Comparison

Pulling the model’s data together and analyzing it as one during the data collection period
has revealed a trend. Figure 4.20 shows the mean water balance over a 24-hour period with the
precipitation and various models. This helps to display the average throughout a 24-hour period
within the data collection period. Two graphs were produced; Figure 4.20 shows the data from

the models not taking into account the precipitation threshold, while Figure 4.21 applies the rain
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threshold, gathered from the flume runoff data. The left axis represents energy for the solar net
radiation, ETp, and ETa. The numbers that are positive represent energy consumption by the

plant’s transpiration, while negative numbers reveal times when the substrate is gaining moisture
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Figure 4.20 Hourly average conditions over the data collection period.
(No rain threshold applied to data.)

caused by precipitation or dew at night. The net radiation line appears in the comparison to
provide the average available sunlight during this data collection period. The Penman-Monteith
model can be noted to follow the same trend throughout the 24-hour period, while the change in
storage of the green roof is following the trend during periods when the average precipitation is
low.

Since the precipitation does skew the change in substrate moisture a precipitation

threshold was established to eliminate times when it rained. Traditionally, the threshold
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eliminates data for a 6-hour window after the last precipitation data are collected. For the
application at WaterShed we were able to measure runoff from the roof and specifically tell
when runoff or ET caused change in storage of the substrate. Table 4.2 in Section 4.1 shows the
runoff values for the various storms taken into consideration. We took the average time from the
recorded rain events to obtain the projected time after the precipitation stopped to account for
runoff. The average from the storms taken into consideration was 88.6 minutes. The average was
used to get a much larger dataset, not limiting the analysis to just times when the flume data was
collected. This threshold was applied to the change in storage (for the entire data collection
period) and anytime during precipitation and 88.6 minutes after precipitation stopped was taken
out, since this was a known period when the roof was not losing moisture due to ET.

Figure 4.21 shows the 24-hour average with the precipitation threshold, where it is now
easier to see the trend throughout the period when the negative values of change in storage are
taken out.

It can now be noted that the trend throughout the day is shifted to the right for the change in
storage compared to the Penman-Monteith model. Several interpretations of this can be
established. First, since the roof is sloped with a slight northern exposure, the whole roof could
be affected less by the net radiation compared to other variables including temperature and wind
speed. Second, the availability of moisture within the substrate was much greater closer to the
end of the day compared to the beginning as a result of precipitation events occurring mostly
after 1 pm on average. In different time comparisons of both ETp and ETa (Figure 4.16), the
trend is that after times when available moisture is high from precipitation the change in storage

is much higher than the predicted ET. The plants now utilize moisture within the substrate at a
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(Rain threshold applied.)

decreasing rate as the time from the last rain event increases. This is mostly caused by stress to

the plants

in the form of reduced available water. Sedum plants can tolerate times with reduced

available moisture, resulting from plant characteristic adaptations (i.e., facultative CAM: C3/C4

to CAM adaptations). Given the mean precipitation is greatest during the last third of the day

this could

account for the shifted soil depletion, as it is easier for plants to utilize the stored

water. With this higher energy consumption during periods when moisture is present, the

discussion
system by

thinner, pr

of irrigation can be brought up, in helping to manage the available energy within the
plant process rather than heat transfer through the roof. Since the roof’s substrate is

esenting more fluctuations of wet and dry periods, irrigation can help reduce the time

the plants are stressed between rain events, allow radiant energy to be used in ET process vs.

absorbing

through substrate, and improve the biomass production rate. Figure 4.22 shows the
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Figure 4.22 Water and energy flux within the green roof.

Relationship between stored moisture within the substrate and energy flux within the green

roof. During times of high stored moisture (7/15/2014), the heat flux is close to -1 W/m?,

while time of low stored moisture (7/30/2014), the heat flux is around -8 W/m?,
relationship between the energy flux and stored moisture within the substrate during the data
collection period. This observation informs the summer conditions of wet and dry periods, while
longer data collection through seasonal differences can help draw a stronger conclusion.

Previous studies conducted on a bigger application have used generic thresholds to

predict when the cutoff is for the change in storage. The application here utilizes the runoff from
the same roof where the other data is being collected. This allows for a more precise turning
point for when the roof is using the rainwater or contributing to overall roof runoff.

The discussion of irrigation can be brought up for a thin, sloped system like this, given

the durations of dry periods within the data collection period. Since the plants did not have
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available water the energy they would otherwise be utilizing is now transferring through the roof
to the building structure. If water was present, it would be helping to reduce this thermal heat
transfer. During the time periods when the VWC was under 0.05, the ETa rates were slowing
down, given the plants were now in a stressed condition, allowing for the energy to otherwise be
absorbed into the growing media. During these periods of low moisture if irrigation is applied,
the energy balance could benefit. Given the set-up of WaterShed'’s site the rainwater eventually
stored in open air cisterns could act as a water source for this process, reducing the overall need
for potable water. The water limiting energy performance analysis would need to compare longer

sets of data, and look more closely at the temperature gradient through the green roof layers.
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5. Summary and Conclusion

With applications of green roofs becoming more widespread in residential sloped
conditions, it is crucial to understand how these systems perform develop performance standards.
The slope characteristics and thin-soil media can be seen to have a major influence on retention
rates within the substrate, providing greater available moisture at the bottom of the slope
compared to the middle and top zones. It cannot be distinguished which variable (slope vs. soil
thickness) has a bigger influence, thus future research is needed for independent control for each
factor. The green roof contributes to stormwater management by reducing the peak flow and
elongating the runoff time, however the total retention in the green roof is small. Nonetheless,
WaterShed’s green roof reduces the peak flow which helps to relieve stress to natural systems
downstream. This lower total retention is important to note, helping to show all the various types
of green roofs and installation characteristics that influence the overall performance. The
reduced rainwater retention within the soil media increases plant stress and can reduce the
building’s performance over time by increasing heat flux through the soil and into the buildings
roof material. The Penman-Monteith model was not able to estimate ET for the sloped, thin soil
media green roof studied. The main reason that P-M could not estimate ET was because it
assumes unlimited soil moisture, which was not the case for our green roof. Thus, application of
PM to estimate ET on green roofs should proceed with caution if soil moisture availability is
questionable. Analyzing ET at a higher resolution with Watershed’s installed monitoring system
resulted in major differences between ETa and ETp, as no consideration was given to water
availability within the substrate. Given moisture within the substrate is the driving force for ET,

this variable is imperative in predicting the overall performance of the roof relative to plant
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functionality. Future manipulation of the equation would have to take this into account when
examining ET with a higher resolution for sloped, thin-soil green roofs.

As the data collection continues at WaterShed Sustainability Center, plant performance
and ET will continue to undergo analysis in comparing the conditions of the green roof.
Attributes like LAI and percent cover determine the plant density of the sedum canopy. This
unique performance of the thin and sloped systems has revealed no significant quantities of
rainwater retained, rather stored short-term and drained out of the system over a longer period of
time by gravity. This stormwater management feature is important within our overall BMP
system, but should be categorized and awarded differently than thicker green roofs. Depending
on the installation goal, this thin green roof application can help reduce flow in streams and
surrounding waterways during peak intensities of storms, releasing the water slowly over a
period of time after the rain stops — ultimately influencing other variables like plant performance
and survivorship, and overall energy transfer. This conclusion helps to bring the performance of
this sloped, thin soil green roof system together, while providing information for a platform for

other comparisons to other green roof types and their performance goals.
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Appendices

Appendix A: Sedum Overview

Sedum Background:

This section provides supplemental
information for the sedum plants used
on WaterShed's green roof. The trays
which held the growing media and
sedum plants were grown at a local
nursery and delivered mature, as the
plants were selected during the growing

season prior to delivery.

Zone:3-9

Height: 3 —5 inches

Spread: 5 — 9 inches

Bloom Time: May to June

Attracts: Butterflies when in bloom

Description: Dense foliage with small linear-oblong leaf
structure, dark green, turning reddish brown for fall and
winter.

Source: http://www.jeeperscreepersusa.com/SEDUM-album-Coral-

Carpet_p_63.html

Zone: 4—-9

Height: 3 -5 inches

Spread: 12 — 18 inches

Bloom Time: August to September

Description: Wedge-shaped leaf structure is medium green
during growing season, turning a deep burgundy in fall

for overwintering.

Source: https://www.gardenerdirect.com/buy-plants-online/570/Sedum-
Stonecrop/Sedum-spurium-Dragons-Blood-Dragons-Blood-Stonecrop

Figure A4 Sedum spurum “Dagon’s Blood”
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* ‘
Figure A.8 Sedum sexangular

“Utah”

Zone:3-9

Height: 3 -5 inches

Spread: 12 — 18 inches

Bloom Time: May to June

Attracts: Butterflies when in bloom

Description: Unigue medium-green leaf color with reddish-
tinged margins.

Source:

http://commons.wikimedia.org/wiki/File:Sedum_spurium_'tricolor'.jpg

Zone: 3-11

Height: 3 -5 inches

Spread: 15 — 18 inches

Bloom Time: May to June

Attracts: Butterflies when in bloom

Description: Blue-gray leaf color ranging to light greens and

yellows during fall and winter.
Source: http://www.onlineplantguide.com/Plant-Details/3668/

Zone:5-8

Height: 3 -5 inches

Spread: 12 — 24 inches

Bloom Time: June to August

Description: Ground cover, yellow-leaved cultivar with

reddish-orange tips in autumn.
Source: http://www.whiteflowerfarm.com/1038220-product.html

Zone: 3-9

Height: 3 —5 inches

Spread: 12 — 18 inches

Bloom Time: May to June

Attracts: Butterflies when in bloom

Description: Dense foliage, with narrow needlelike structures,

deep green to red tips in fall and winter.
Source:
http://www.netherlandbulb.com/index.cfm?fuseaction=bulbs.plantDeta

il&plant_id=7209
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Appendix B: Monitoring System Sensor Details

Monitoring System Background:
This section provides supplemental
information for the monitoring system

installed on WaterShed. The various

SENSOrs

based on the desired parameters needed

for either energy or water balance

models.

listed below were selected

Table B.1 Green roof datalogger sensor details.

Green Roof Sensor Type | Sensor Description Brand Model # Qty. | Scan
Vegetation Temp Apogee Infrared Radiometer Campbell SI-111 3 5 sec
Under-Tray Temp Thermocouple Probe Campbell 109-L 3 5 sec
EPDM Surface Temp Apogee Infrared Radiometer Apogee SI-111 2 5 sec
Net Radiation 4-Component Net Radiation Sensor | Hukseflux | NRO1-L 1 5 sec
Soil Heat-Flux Soil Heat Flux Hukseflux | HFPO1-L 2 5 sec
Soil Moisture & Temp Water Content Reflectometer Plus Campbell CS655-L-DS | 9 5 sec
Total roof runoff Pressure Transducer (SDI-12) Campbell CS451-L 1 20 sec
Table B.2 PV roof datalogger sensor details.
PV Roof Sensor Types Sensor Description Brand Model # Qty. | Scan
Panel Surface Temp Surface-Mount Thermocouple Campbell 110PV-L 3 5 sec
Probe

Exposed Roof Temp Infrared Radiometer Apogee SI-111 2 5 sec

Shaded Roof Temp Infrared Radiometer Apogee 109-L 3 5 sec

Total roof runoff Pressure Transducer (SDI-12) Campbell SI-111 1 5 sec

Net Radiation 4-Component Net Radiation Sensor | Hukseflux | NRO1-L 2 5 sec
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Table B.3 Weather station datalogger sensor details.

Weather Station Sensors | Sensor Details Brand Model # Qty. | Scans
Radiation Hukseflux Pyranometer Hukseflux | Lp02-L 1 10 sec
Rain Gauge Hydrological Services HS TB4MM-L 1 10 sec
Temperature & Humidity Temperature Probe Campbell | CS215-L 1 10 sec
Water/Soil Temperature Temperature Probe Campbell | 109-L 1 10 sec
Leaf Area Wetness Devices Leaf Wetness Sensor Decagon LWS-L 2 10 sec
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Appendix C: Calculations

Calculation Background:
This section provides supplemental information for quantifying retention of green roof for

runoff, weir runoff equation (Equation 3), and Penman-Monteith ET model (Equation 6).

Roof Footprint: Upscaling for Total Runoff Volume

WR Area: 77.26 sq. ft (7.177 sq. m)

GR Area: 311.99 sq. ft (28.98 sg. m)

Total Area: 389.25 sg. ft (36.16 sq. m)

P: Precipitation

GR Thickness: Depth of green roof soil 2.5 in (0.064 m)

GR Rain In: Rainwater that has fallen on green roof footprint
WR Rain In: Rainwater that has fallen on white roof footprint

Total Roof Runoff: Volume of water entering gutter system from entire roof

1[m]
P [mm] * 1000 [rmd] =p[m] (Eq.C.1)

3

m
A Storage Iﬁl * (GR thickness [m] * GR Area [m?]) = GR Retention [m3] (EQ. C.2)

(P [m] * GR Area [m?%]) = GR Rain [m?*] (EQ.C.3)
(P [m] * WR Area [m?]) = WR Rain [m3] (Eq.C.4)
(GR Rain In [m3] — GR Retention [m®*]) + WR Rain In [m3] = Total Roof Runoff [m®] (Eq. C.5)

The series of equations above are used to quantify the total amount of rainwater coming
off the green roof using the volumetric water sensors in the soil of the green roofs to predict

retention rates. First precipitation is converted from millimeters to meters (Eq. C.1). The
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measured retention rate uses the depth of the soil media and area of the green roof to upscale the
predicted volume change to the entire green roof area (Eq. C.2). The total available rainwater
falling on the system determines the green roof footprint input (Eq. C.3). Due to incomplete
coverage of the roof footprint with the green roof, the white roof area would act as pure runoff to
the total runoff (Eqg. C.4). The difference between the green roof total input and retention are
added to white roof runoff to return total runoff entering gutter system (Eq. C.5). We utilized
this method for each storm event to quantify the total storm storage within the substrate, which

reduces overall runoff volume.

Weir Equation: C and K equations

The variables C (Discharge Coefficient) and K (Head Correction Factor) are based on the
angle previously chosen for the weir. For the application on WaterShed, the C and K values are
reported in Table C.1.

C = 0.607165052 — 0.000874466963 6 + 6.10393334x1072 2

K (ft) = 0.0144902648 — 0.0003395535 6 + 3.29819003x107° 6% — 1.06215442x1072 63

Table C.1 Values of C and K for WaterShed’s flume weir runoff boxes.
Angle of v-notch  Cvalue Kvalue

Bathroom | 40° 0.5722  0.0055
PV roof | 70° 0.5786  0.0032
Green roof | 50° 0.5787 0.0044

Predicted ET Equation

Cn
BT 0.408A(Rn - G) + ]/W (6’5 - ea)uz
P A+y(1+ Cquy)
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The potential ET (ET,) [mm/day] based on selected reference crop, calculated every 15 minutes
from onsite data collection and predetermined constants. Assuming well-watered crop.
Slope of saturation vapor pressure curve (A) [kPa/°C] was calculated monthly using the average

temperature collected during the same period onsite, using the following equation:

( 17.27 T)
2504 exp\T+237.3

(T+237.2)?

A= (Zotarelli et al., 2013)

Net radiation (R;,)

2 .
[MJ/m-day] : Up

was automatically Rsm Nt

Shorl-Wave
Radiation

collected onsite and (visshle)
R'& or DOWn

N
averaged over the Ruin l,nng.e»lvu\:e

R o p Radiation
(Tlrared)

15'minute data ; : : R our
interval. The
program took the

sum between the

calculated incoming
I Figure C.1 Net radiation breakdown of In/Out longwave and

net radiation and the s rtyyave radiation.

outgoing net radiation. The various mean time stamps used the 15-minute data. Figure

C.1 helps to show what component of the sensor (Up/Down) corresponds to the labeled

data (In/Out) for both short and longwave.

Heat flux density in soil (G) [MJ/m?day] was collected onsite automatically from two locations
over the 15-minute data collection period. The average of the two sensors was used to

eliminate slope influences on heat flux. The heat flux data are usually neglected due to

69



long-term averages (Frevert and Schwab, 1966), but analyzing on a higher resolution

made measuring the variable necessary.
R, = R,s— R,  (Zotarellietal.,2013)

The psychrometric constant (y) [kPa/°C] was calculated once, based on the following equations:

y = .000665 P, where P is the mean average atmospheric pressure [kPa] (Frevert and

Schwab, 1966).

293 0.0065Z>5'26

P=101.3< 293

where z is the weather station elevation above sea level [m]. (Fangmeir, 2006)

The calculated P for WaterShed was 99.44 kPa, with the elevation of 153 m above sea level.

Cn is a constant, determined by a crop reference (grass), with the value being 900 per hour or

37.5 per 15 minute (Frevert and Schwab 1966).

Cd is another constant, determined by the crop reference, with a given value of 0.34 no matter

the time interval (Frevert and Schwab 1966).

Temperature (T) [°C] data were collected automatically onsite every 15 minutes. Sensor was

approximately 18 inches off the roof surface. Humidity was also collected with this sensor

Mean saturation vapor pressure (es) was calculated from the following equation (Frevert and

Schwab, 1966):

17.27T

es; = 0.6108(T+237-3), where T is air temperature [°C]. (Zotarelli et al., 2013). e, was

calculated on a 15-minute interval, using the onsite temperature collection.
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The mean actual vapor pressure (e,) was calculated using the relative humidity collected onsite
in the following equation:
e, = Ueg, where U is relative humidity [%], e, is saturated vapor pressure, with the mean being
calculated every 15 minutes.
The average wind speed (u,) [m] is measured with the onsite weather station, averaged over the
15-minute collection interval.

Conversions within ET prediction model (Zotarelli et al., 2013):

Latent Heat Flux Conversion: ET, [ﬂ] * 2.45 ZMJ ]= AET [ ZM] ]
day m=day. m4 day

Mj_], 1w
m? dayl " 0.0864 [ 15]
m

w
m2 day

Energy Conversion: AET [ = ET [
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Appendix D: Environmental Conditions

Precipitatio Data
June 18 - September 15, 2014
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Figure D.1 Precipitation data (15 min data).
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Figure D.2 Relative humidity data (15 min data).
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Figure D.3 Temperature data (15 min data).
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Figure D.4 Wind Speed data (15 min data).
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Figure D.5 Soil depletion data (15 min data).
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Appendix E: Methods for ImageJ Software

Calculation Background:

This section provides supplemental information for processing green roof pictures to
achieve a percent cover number. The steps below rely on the ImageJ software, which
can be downloaded from the following link: http://imagej.nih.gov/ij/download.html

Once software is downloaded open the desired picture of the area needed to be analyzed: File >
Open > ‘file’

Crop the designated area you want analyzed by using a polygon tool in the top toolbar. End
polygon by clicking on first point.

To erase outside pixels select Edit > Clear Outside
Select Image > Crop to get new image cropped to the canvas size.

Select Save image as to obtain separate images of cropped area and plant area for future
reference

At this point with the area still selected take a measurement of the entire area by selecting
Analyze > Measure (Ctrl + M)
This will bring up a table with the file name and pixel count. Other variables can be
added but for this application the pixel count is all that is needed.

Adjust the color threshold of the image by selecting Image > Adjust > Threshold

Once the threshold window appears ensure the settings are in the HSB Color mode at the bottom,
with the rest of the settings as follows:
Hue: 0 — 100
Saturation: 46 — 255
Brightness: 1 — 255
Default threshold method
Threshold color: Red (overlay)
Dark background selected
Click Select at bottom of Threshold window and select vegetation

To select vegetation by itself, right click on the image and select Properties > Edit > Erase
outside
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The vegetation should be the only thing left. At this point take a new measurement by selecting
Analyze > Measure or (Ctrl + M), which will populate a new pixel count of just the vegetation.
“Save As” this image as well for future reference.

d Threshold Color [=][= =]

Hue

¥ Pass

_I 4 06.10.2014_Zone2_cropped jpg (75%) ==
kO

149011204 pixels, RGB, 6 8MB
K| I »| 100

Saturation

¥ Pass
“ DL
Kl | »|ess
Brightness
W Pass
<] s ‘ Al R
< 1 v]2ss ; %?, : “s % ) W~ 8
Thresholding method: m i — e . !
Threshold color: [Red | Figure E.1 Threshold set to only select vegetation
Color space: [Hs8 -] within respective zone of green roof.

Iv Dark background

Original | Filtered | Select Samplel

Stack Macro Help
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Appendix F: Percent Cover Image Details

Percent Cover Details Background:
This section provides visual results for the percent cover of the green roof using ImageJ

software (Discussed in Appendix E).

Selected Selected
Vegetation Vegetation
Only Only

Zone 1 -9/18/2014

(Vegetation Pixels) 724,638
(All Pixels) 1,468,133

(Vegetation Pixels) 1,006,562
(All Pixels) 1,630,630

=61.73% =49.36 %
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Appendix G: Flume Detailed Drawings
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Appendix H: Flume Calibration

Flume Calibration Background:

This section provides the direct measurements made to calibrate the flume sensors

installed on WaterShed to get runoff rates and volumes. The equations populated by the

correlation were used as the calibration number in the weir equation (Equation 2).

Table H.1 Bathroom flume.

Sensor Bathroom

Height Sensor Hose Flow
162.4 0.00924 0.0096
1345 0.00191 0.00184
139.7 0.0028 0.00272
145.1 0.00393 0.00398
148.8 0.00484 0.00457
151.9 0.00578 0.00582
145.7 0.00239 0.0065

y =-2.8185 x + 0.0005

Table H.2 PV flume calibration.

Sensor PV

Height Sensor | Hose Flow
181.5 0.012 0.0096
156.7 0.0039 0.00184
161.2 0.0048 0.00272
168.5 0.00654 0.00398
171.4 0.00764 0.00457
174.5 0.00872 0.00582

y = -2.8185 x + 0.0005

0.012
0.01 y=1.0577x-0.0003
R?=0.9972
0.008
0.006
0.004

0.002

Hose Flow Rate (CFS)

0
0 0.002 0.004 0.006 0.008 0.01

Flume Flow Rate (CFS)

Figure H.1 Bathroom flume correlation and
calibration curve.

0.012
Y 0.01 |y=0.9187x-0.002
L R2 = 0.9803
@ 0.008
g
&
> 0.006
[e]
T 0.004
Q
8 0.002
oo

0

0 0.005 0.01 0.015

Flume Flow Rate (CFS)

Figure H.2 PV flume correlation and calibration
curve.
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Table H.3 Green roof flume calibration. 0.012

Green 'g o ® 0.01
Sensor Roof Hose = ’
Height Sensor Flow § o 0008
168.7 -0.00238 | 0.009957 2 e 0.000
172.2 -0.00304 0.0096 P I .. 0004
145.8 -0.00037 | 0.00184 £ .
150.6 -0.00063 | 0.00272 o
156.6 -0.00109 0.00398 -0.004  -0.003  -0.002  -0.001 0
159.3 -0.00131 0.00457 Flume Flow Rate (CFS)

| y = -2.8185 x + 0.0005 | Figure H.3 Green roof flume correlation and

calibration curve.

- 0 i \ — L 1
Figure H.4 Flow calibration using given flow Figure H.3 Flow calibration: Note V-notch and
rate from hose coming into the system. height of water, dependent on water flow rate
coming into the system behind back baffle.
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Appendix I: Individual Zone VWC vs. Percent Cover
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] =
correlations for each VWC sensor on g0-0350 5
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the green roof. These VWC sensors 0.0250 ¢ y = 0.0298x+ 0.025
. R? =0.0235
are varied among the 3 zones, top, 0.0150
35.00% 45.00% 55.00% 65.00%
middle, and bottom (sensors depicted Percent Cover
in Figure 1.1).
VWC Zone 2 VWC Zone 3
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percent Cover Percent Cover
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o 00350 ¢ __ 00550 ¢ R?=0.273
E . 2 °
- [ ]
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VWC Zone 6 VWC Zone 7

0.0950 0.0850
0.0850 . y=-0.1712x+ 0.1362 0.0750 ‘.
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Whole Roof Area: 389.25 sq ft

White Roof area: 77.26 sq ft

Figure 1.1. Layout of VWC sensors, corresponding to the numbered zones
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Appendix J: Energy Balance Graphs
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Figure J.1 Mean 24-hour net radiation variables: long and shortwave radiation.
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Figure J.2 Mean 24-hour soil heat flux: negative value represents energy gain, while positive
represents energy loss
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Figure J.3 Mean 24-hour latent heat data.
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Figure J.4 Mean 24-hour overall energy balance.
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Glossary

Blackwater: Effluent water draining from the toilet and kitchen sink within the house.

Evapotranspiration (ET): The vaporization of water through direct evaporation from wet
surfaces, plus the release of water vapor by plants through leaf pores (transpiration).
(“Climate and Weather Terms Glossary,” 2014)

Field Capacity: Maximum amount of water stored within the substrate, held against the force of
gravity.

Greywater: Effluent water draining from the dishwasher, bathroom sink, shower, and washing
machine.

Leaf area index (LAI): A relationship to the plant’s leaf coverage compared to visible ground.

Rain event: A period of precipitation determined by a rain gauge installed onsite, determining
the start and stop times of an event occurring.

Roof runoff: Determined by the measured runoff in the flumes attached to the 3 downspouts on
WaterShed, resulting in a flow rate from the respective roofs.

Runoff: Determined by the start and stop times of the rain gauge, while allowing a 6-hour
window after the last precipitation event.

Stormwater: Water that accumulates due to precipitation.

Stormwater retention: The absorption of rainwater within the substrate of the green roof;
substrates can absorb a finite amount of this liquid for use during times between rain

events.
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